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USING AUTOPLAY MEDIA STUDIO TO CREATE ELECTRONIC-LEARNING TOOLS 

 

Murodova Guli Buronovna 

senior lecturer department of information technology, BSU, 

Ataeva Gulsina Isroilovna 

senior lecturer department of information technology, BSU 

 

Abstract: 

Background. The increase in the flow of information every year makes it impossible in some 

cases to solve various problems without the use of computer technology. Therefore, one of the tasks 

of improving education is to equip students with knowledge and skills in using modern computing 

technology. At the same time, it is necessary to give all students not just knowledge about the use of 

modern computing technology and the prospects for its development, but the ability to competently 

use it to effectively solve a wide variety of problems. 

Methods. The transfer of the experience accumulated by humanity to the new generation is 

carried out through education. Education is the side of upbringing, which includes a system of 

scientific and cultural values accumulated by previous generations. One of the modern teaching 

aids at the present time is electronic textbooks, which can be created using special software. 

Program AutoPlay Media Studio is a powerful tool for creating multimedia electronic editions for 

various purposes: presentations, electronic books, multimedia applications. 

Results. The properties and capabilities of the AutoPlay Media Studio program are 

considered. When creating an experimental electronic textbook, the AutoPlay Media Studio 

program was used , with which you can create electronic textbooks, covers for CD\DVD, 

presentations, simple games, electronic photo albums, collections of video files with easy viewing, 

simple audio and video players. AutoPlay Media Studio has a large number of ready-made 

templates: to design a menu with various buttons for launching programs, playing sounds, printing 

files, opening Internet sites. 

Conclusion. Electronic tutorials are a promising area of informatization of education, and 

their importance in the future will only increase. Software tools for creating electronic tutorials are 

endless possibilities and one of them is the AutoPlay Media Studio program. 

Keywords: computer, education, e-tutorial, software AutoPlay Media Studio, presentations, 

electronic books, multimedia applications, audio, video, graphics and text, of flash-animation, 

animated objects. 

 

Introduction. Our modern world can no longer be imagined without a computer, which has 

penetrated all areas of the educational process. The widespread use of modern computers, which are 

characterized by versatility and ease of use, makes it possible to use their capabilities to solve the 

widest range of diverse tasks in all areas of human activity. 

The increase in the flow of information every year makes it impossible in some cases to solve 

various problems without the use of computer technology. Therefore, one of the tasks of improving 

education is to equip students with knowledge and skills in the use of modern computing 

technology. At the same time, it is necessary to give all students not just knowledge about the use of 

modern computing technology and the prospects for its development, but the ability to competently 

use it to effectively solve a wide variety of problems. A much deeper process is being built over 

computerization - informational, covering all aspects of social life. This is due to the direct 

introduction of modern computers in almost all spheres of science, technology, and economics [1]. 
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Since any human activity begins with learning, the computer is rightfully invading this area 

too. 

Therefore, the most important function of upbringing - this is the transfer of the experience 

accumulated by mankind to the new generation - is carried out through education. Education is that 

side of upbringing that includes a system of scientific and cultural values accumulated by previous 

generations [2]. 

The first steps in the field of informatization of education were made in our country in 2005, 

when an extremely important government decision was made "On the creation of a public 

educational information network of the Republic of Uzbekistan" dated 28.09.2005. 

The planned results should, first of all, ensure the readiness of the future teacher for practical 

activity, which is determined by the formation of professional skills, including methodological 

skills. 

Compiling such lists in a methodological course is a rather difficult task, since ethodological 

training is determined not only by knowledge and skills specific to a given academic subject, but is 

also closely related to the didactic, psychological and mathematical training of a future specialist. 

Therefore, in any methodological course, two tasks should be set. 

The first is the arming of didactic skills related to planning, conducting and analyzing a 

lesson. 

The second is equipping future teachers with methodological techniques that will allow them 

to manage the activities of students in the study of specific issues of content. 

The acceleration of scientific and technological progress in all spheres of human activity is 

inextricably linked with the informatics industry. 

Methods. The educational information environment consists of many interacting components. 

These are systems for automating the educational process, distance learning systems, and 

information and reference systems. The content basis of the educational environment is electronic 

educational resources and services provided by various educational institutions. 

It is the effective use of new didactic and informational opportunities that ensures the required 

quality of the resource. First of all, we are talking about the implementation of branched and 

multilevel navigation through the materials of the resource and a rich reference apparatus. The 

correct implementation of these two components, along with, of course, the quality of presentation 

of the material itself and the relevance of the topic, will determine the degree of its use in the 

educational process [1]. 

Electronic textbooks are currently one of the modern teaching aids [3]. Electronic teaching 

aids are classified as audiovisual teaching aids and can partially or completely replace or 

supplement existing textbooks [4]. Electronic teaching aids, being one of the forms of computer 

training systems, can be classified as automated training systems [5]. 

The capabilities of the electronic textbook significantly affect the development of the student's 

personality, equip a person with the skills to use information and communication technologies and 

contribute to the activation of students' independent activity in the lesson. 

Sometimes, an electronic tool is understood as a collection of data in digital form, used for 

use in the educational process. But according to this definition, any scanned textbook could be 

called an electronic textbook. If we compare the benefits of using this kind of digital resources with 

the harm caused to health, immediately there is doubt about the appropriateness of their use. An e-

book is a more appropriate name for such a resource, 

The computer today is not a monologue tool, but rather a partner in dialogue, a pleasant 

interlocutor who helps in learning. For a computer to become such, an electronic teaching aid 

should be understood not just a set of digitized data, but something else. 

An electronic teaching aid is a training complex designed for use on a computer, containing 

educational material in various forms, a search system, interactive feedback tools and allowing a 

student, independently or with the help of a teacher, to master the training course or its section. [6] 
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The main purpose of using digital resources in learning is to communicate information, form 

and consolidate knowledge, form and improve skills and abilities, increase interest in learning, 

control the assimilation of knowledge and others. 

An electronic study guide must meet the requirements that distinguish it from a traditional 

printed textbook: 

 All structural components must have a consistent style that is well understood by the PC 

user. 

 There should be a well thought out and convenient navigation system. 

 The theoretical material should be presented in various forms, including multimedia 

elements. 

 The presence of interactive fragments to ensure dialogue with the learner. 

 Availability of information retrieval system. 

 The possibility of supplementing or changing the educational material when such a need 

arises, which is very important for such a dynamically changing discipline as "Informatics". 

The e-tutorial you create can either build on an existing printed tutorial (or textbook) or be 

created from scratch. 

It becomes clear that a creative teacher who actively uses information and communication 

technologies in the classroom and in extracurricular subject activities should be able to 

independently create the necessary electronic textbook. In the educational environment, there is an 

opinion that an electronic textbook is the lot of programmers, therefore, commercial products are 

most often used to prepare for educational activities. 

Results. However, there is a tool that allows you to quickly and efficiently create educational 

projects that are not inferior in functionality to the products of professionals. 

This program is AutoPlay Media Studio - a software solution that provides the creation of 

various complex projects: from disc menus to a complex shell of multimedia textbooks. You can 

easily design an electronic study guide using any content - audio, video, graphics, text, flash- 

animation. 

AutoPlay Media Studio is a powerful tool for creating multimedia electronic publications for 

various purposes: presentations, electronic textbooks, multimedia applications. 

AutoPlay Media Studio is a program for visually creating skins for autoplay discs. A disk 

autorun shell is understood as a small program with a set of functions for viewing and working with 

the contents of the disk. This is certainly too narrow a definition of the capabilities of Autoplay 

Media Studio . With it, you can create electronic textbooks, CD / DVD business cards, 

presentations, simple games, electronic photo albums, collections of video files with convenient 

viewing and much more. And all this is virtually without knowledge of programming languages. In 

the Autoplay Media Studio extensive collection of visual tools and settings that allow you to create 

programs "quickly and easily." 

Areas of application for Autoplay Media Studio : 

 Autorun menu for discs (for games, software products, etc.); 

 Reporting (annual financial statements, etc.); 

 EBooks; 

 Digital magazines; 

 Interactive presentations, slide shows; 

 Software development; 

 Tutorials; 

 Custom web browsers; 

 Multimedia business cards; 

 Prez - releases; 

 Business planning; 

 Virtual photo albums; 

 And much more. [7] 
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Let's look at a number of areas where you can apply Autoplay Media Studio. 

CD-ROM AutoRun Menu. This is where it all started. AutoPlay Media Studio is actually an 

industrial standard for creating professional menus for optical applications carriers. In a matter of 

minutes, you can create a menu for viewing documents, reviewing disk contents, go to an Internet 

resource, send an e-mail and much more. 

Multimedia business cards. Making original multimedia applications isn't big complexity in 

the environment of this tool. As a basis, you can take the existing standard delivery templates and 

examples. 

Own WEB-browsers. An example of the original browser is among the ready-made 

templates. Little improving it, you can create a fully functional tool for working with network 

resources. 

Educational interactive applications. Integration of various formats of information 

presentation (text, audio, video) using navigation tools makes it possible to create convenient, 

quality training courses. 

Own audio players. It's easy enough to create your own player with the original interface, 

support for playlists and navigation. 

Slide show. The ability to create colorful slideshows from photos with musical 

accompaniment and navigation will not be difficult if you use Autoplay Media Studio. 

Interactive presentations. Create interactive presentations with video inserts, audio support, 

links to network resources - a matter of a few minutes. Can use both ready-made templates and 

create presentations from scratch. 

Catalogs. The latest versions of the program have tools for working with databases. 

Therefore, developers have the opportunity to create illustrated catalogs with search and sort 

functions. 

Advertising discs and business cards. Using the built-in programming language, as well as 

complementing the flash product animation, you can create bright advertising brochures and 

business cards on optical media. 

Resumes, electronic portfolios. The electronic portfolios created by using AutoPlay Media 

Studio. For implementation, digital photos, videos and description text associated with navigation 

elements. 

Naturally, the list can be continued indefinitely. The above are just a few thematically 

grouped areas. 

AutoPlay Media Studio - does not require programming knowledge and is very quickly 

mastered, in addition, the delivery includes ready-made templates for decorating the menu with a 

variety of buttons for launching programs, playing sounds, printing files, opening Internet sites, and 

so on, allowing you to easily make a CD interface most friendly and beautiful. 

Discussion. Program AutoPlay Media Studio is designed to create multimedia projects. With 

AutoPlay Media Studio, you can create electronic textbooks, CD/DVD covers, presentations, 

simple games, electronic photo albums, collections of video files with easy viewing, simple audio 

and video players. AutoPlay Media Studio has a large number of ready-made templates: to design a 

menu with various buttons for launching programs, playing sounds, printing files, opening Internet 

sites. The project can be decorated with music, video, flash- animation, text. The project can include 

graphic, video, audio and animation objects prepared using specialized software. The capabilities of 

this program significantly increase with the skills of working with the programming languages 

C, C ++, Java, Visual Basic. Any object of the project can be assigned a specific action. The 

program provides a wide variety of different actions that can be associated with objects. It is 

possible to create free-form autorun windows using transparency masks. Such a mask can be 

graphic files in the formats .jpg, .bmp, .png. An application created with AutoPlay Media Studio is 

presented as an object model at the final stage. This model consists of a group of separate pages on 

which you can place any objects (graphics, text, video, Flash, HTML, etc. 

The capabilities of AutoPlay Media Studio can be extended using additional plug-in modules. 

With their help, you can automate some frequently performed tasks. The finished project can be 
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presented in the form of a self-extracting archive, saved in a separate folder on the hard disk, or 

burned to CD/DVD/BLu-Ray directly from the program. The program creates a graphical disk shell 

and all the necessary files for its autorun. At the same time, you do not need to have AutoPlay 

Media Studio installed on your computer to run the project. 

The main advantage of AutoPlay Media Studio is its ease of use. The user-friendly interface 

allows you to create the simplest application in the first a few minutes of acquaintance with the 

program. Drag and Drop technology combined with built-in programming language does not 

restrict the developer in writing projects of any orientation and level of complexity. 

In addition to the capabilities of the program itself, the developer has applications a lot of 

plugins that can be downloaded from both the official site programs and from third-party 

developers. 

The creation of a project in the program is done entirely on a visual basis, drag and drop 

images, text, music and videos, dropdowns and web content directly into the development 

environment with the mouse. Built in library over 250 actions add interactivity to your projects. 

INTERFACE OF THE PROGRAM. The AutoPlay Media Studio 8.0 window (Fig. 1) includes 

a menu bar, toolbars, project explorer, object properties panel, work area and project size scale. 

Menu bar Toolbars Workspace Project explorer Object properties panel Project size scale Fig. 

Menu bar The menu bar contains menu titles: File, Edit, Align, Page, Dialog, Object, Project, 

Publish, View, Tools, Help. 

 
Fig. 1. Window Program AutoPlay Media Studio 8.0 

 

1 - the working field of the program. This is where we place the objects of our 

application:text, graphics, video, objects for working with sound, tables and others. 

2 - the main menu of the program, which, like most software products has a nested 

hierarchical structure. To access menu items you need to click once with the left mouse button on 

the name of the menu and in the opened select the desired item in the list by single-clicking the left 

mouse button. 

3 - a set of the most frequently used operations, presented in the form graphic elements. To 

activate any of the items, you need to click on him once with the left mouse button. For each of the 

items opens the corresponding dialog box. When you hover over any of the items a pop-up hint 

about the purpose of this item appears. 

4 - (Project Explorer) - project explorer. Designed to work with objects who participate in the 

project, that is, with those objects that are present in the working field (1) of the project. With this 

window we can group objects, do what - then the objects are temporarily hidden, eg. With this 

window we can change properties of several objects (pre-selected). 
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5 - (Properties) - properties. the properties window of the selected object. With this window 

we can change any parameters of the selected object: width, height, color, lettering, location on the 

work field and much more. 

6 - (Project Size) - project size. In this block, we can observe such project parameter, as the 

size in Mb. Needed in order to navigate: fit our project on the selected medium (CD / DVD) or not. 

Using the View menu item, you can supplement the program interface additional toolbars. 

You can hide unnecessary ones. It is possible to drag windows across the working to build up 

programs for the purpose of individual arrangement of instruments. For this left by clicking the 

mouse grab the window by the title bar (blue area) and without releasing the left drag the mouse 

buttons. 

Work in the AutoPlay Media Studio environment. 

1. Start AutoPlay Media Studio by double-clicking the left mouse button on the icon 

(Fig. 2). 

Fig. 2. AutoPlay Media Studio icon 

 

2. In the Welcome to AutoPlay Media Studio dialog box, select Create a new project and left-

click. 

3. In the New Project Creation dialog box that opens (Fig. 3), enter the name of the project, 

for example, Graduation work in the Your Project Name: text box. Fig. 3 Select the Blank Project 

template by double-clicking the left mouse button and in the Confirm Overwrite window answer 

Yes. The Page1 page of the new Final work project will open in the AutoPlay Media Studio 

working window. Fig. 3. 

 

 
Fig. 3. Dialogue window - Create a New Project 

 

Note. The window AutoPlay Media Studio by default should be set toolbar: Pages (Pages), 

Standard (Standard), Objects (Objects). If these panels are not installed, install them using the 

commands: View> Toolbars>. The default edit window should be set to Large. If a different size of 

the editing window is set, then using the command: Project> Settings open the Project Settings 

dialog window. In the Window Size drop-down list, find the Large size and left-click. Click button 

OK. 
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Here's a quick guide to getting started with AutoPlay Media Studio. A more detailed 

description of work in the program, readers can find at the site address 

https://docplayer.ru/30039772-Sozdanie-multimediynyh-prilozheniy-v-srede-autoplay-media-

studio.html. 

Answers to questions about Autoplay media studio 

"Is it possible with this wonderful program to burn to DVD discs for ordinary players to 

watch videos on your home TV?"  

By and large, no. Autoplay media studio creates programs with the EXE extension. This file 

type is not supported by conventional DVD players. You can try to create an Autoplay media studio 

project and place the AUDIO_TS and VIDEO_TS (movie) folders in the project root. Then, 

perhaps, it will turn out that the DVD player will “see” and play the contents of the folders 

“AUDIO_TS” and “VIDEO_TS”, and in Windows the EXE file of your program will be launched. 

"When adding a file to an action button (open document function), an error appears" 

The following validation error has occured: The document to open could not be found "- Like 

the file was not found. But the file (presentation) is in the project folder and opens fine. What do 

you advise?". 

The file name may be too long. Or try renaming it using only English letters, numbers, and 

dashes or underscores. 

"I insert a" New PDF object ", set the path to the PDF file (the file contains text and 

hyperlinks to open a web page). I launch the program, the text is displayed correctly, but nothing 

happens when I click on the links. " 

Try in the Adobe Reader settings in the Trust Manager section, click on the Change settings 

button and in the window that appears, select Allow PDF files to access all sites. 

“Is it possible to make it so that after the end of the video, it seems to itself come out of full 

screen mode and return the menu? As, for example, on purchased DVDs after the end of the movie, 

it goes back to the menu.” 

Try on the Script tab and place the below code on the On Finish tab for the video object. 

 
"Tell me how to make the window of the finished project can be dragged across the screen."  

In the project settings, on the Apperance tab, enable the Movable option. 

"Why don't thumbnails appear in the Select File window when I select buttons?"  

In this window, change the display mode, the Views button in the upper right corner, to 

Thumbnails. 

“How to organize the download of files through the disc menu? Those. I created a disc menu, 

placed an inscription in one of the sections. I need to start downloading the file (archive) to the 

user's computer when clicking on this inscription, like downloading from the Internet. "  

In the properties of the caption on the Quick Action tab, select View Website, in the Web site 

field, enter the address for the file you want to download. 

How long does it take to create a program?  

A fully functional program can be created in minutes, for example, based on a template. It all 

depends on what exactly you want to do. But, in any case, the development of a software product of 

a similar complexity in Autoplay media studo will be faster than in Visual C ++, Delphi or Visual 

Basic. I also want to add that, provided that the program is at a sufficient level, 60-80% of the time 

is spent on creating content (video, audio, text, images, and so on) and developing a design 

(working in a raster or vector editor). It should also be taken into account that the design (idea) of a 

software product can take a very long period in comparison with the development. On average, it 

takes me about 3-6 hours of continuous work to create such programs, provided that all the content 

is already ready and there is a plan of what specifically I want to do. At this time, the design 

development in Photoshop (or Illustrator), the direct creation of the first version of the program in 

Autoplay media studo 8.2 and several cycles of testing-fixing / changing the created program are 

included. 
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Who is already using Autoplay media studo?  

This software product is used by everyone, from individual developers to large companies. 

Do I need to pay for created programs?  

No. After purchasing a license for Autoplay media studo, you do not have to pay anything 

else. 

Can you distribute created programs by email?  

Yes. Autoplay media studo can export your created program to a self-extracting archive. You 

can attach it as an attachment to the letter. If the file is too large, you can upload it to the cloud 

storage and mail the download link. 

Does Autoplay Media Studio recognize mouse clicks and movements?  

Yes. Recognized by pressing the left and right mouse buttons, movement, hovering over an 

object and loss of focus from the object. You can assign a reaction to all these actions. You can 

assign the program's reaction even when the user just moves the mouse. 

Can AutoPlay Media Studio read and write registry values and XML files?  

Yes. In addition, it is possible to determine whether the user account under which the program 

you have created has read and write permissions to the registry. 

Can I add my own data to the properties of the executable file of the generated program? 

Yes. 

Conclusion. Based on the foregoing, it can be concluded that an electronic textbook is a 

comprehensive-purpose educational software system that ensures the continuity and completeness 

of the didactic cycle of the learning process: providing theoretical material, providing training 

educational activities and control of the level of knowledge, as well as information retrieval activity, 

mathematical and simulation with computer visualization and service functions subject to 

interactive feedback. An electronic textbook, being a multifunctional tool, is able to replace some of 

the traditional teaching aids. 

Electrons tutorials are a promising area of informatization of education, and their importance 

in the future will only increase. Software tools for creating electronic tutorials are endless 

possibilities and one of them is the AutoPlay Media Studio program. 
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Abstract: 

Background. Many physical processes are represented by a system of equations of the 

hyperbolic type of the first order. For example, a system of acoustic equations, electromagnetic 

vibrations, dynamic equations of the theory of elasticity, and others. It is well known that second-

order equations are derived from them by a number of additional constraints. Solving inverse 

problems directly leads to solving these systems. Systematic research in this area were conducted in 


